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Relevant Knowledge 

A database is an organized collection of data. You can visualize it as a container of 

information. 

The data is typically organized to model relevant aspects of reality (for example, the 

availability of rooms in hotels), in a way that supports processes requiring this information 

(for example, finding a hotel with facilities such as Laundry, GYM etc…). 

 
Suppose if you own a stationary shop, you need to keep detailed records of the materials 

available in your shop. You also need to store information about pricing, stock levels for 

reordering, old stocks, etc. While in the manual system, you would maintain several files 

with different bits of information; in the computerized system you would use database 

programs such as Microsoft Access, OpenOffice.org Base, and MySQL, to organize the 

data as per your business need. 

The database concept has evolved since the 1960s to ease increasing difficulties in 

designing, building, and maintaining complex information systems (typically with many 

concurrent end-users, and with a large amount of diverse data). 

In this lesson, you will learn database concepts and to work with a Database Management 

System (DBMS). 

 
Database Management System 

A database management system is a software package with computer programs that 

controls the creation, maintenance, and use of a database. It allows organizations to 

conveniently develop databases for various applications. A database is an integrated 

collection of data records, files, and other objects. A DBMS allows different user 

application programs to concurrently access the same database. 

Well known DBMSs include Oracle, IBM DB2, Microsoft SQL Server, Microsoft 

Access, PostgreSQL, MySQL, FoxPro, and SQLite. 

 
Data can be organized into two types: 

• Flat File: Data is stored in a single table. Usually suitable for less amount of data. 

• Relational: Data is stored in multiple tables and the tables are linked using a common 

field. Relational is suitable for medium to large amount of data. 

MANAGEMENT SYSTEM 

DATABASE OF CONCEPT APPRECIATE 1: SESSION 



3 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

Database Servers 

Database servers are dedicated computers that hold the actual databases and run only the 

DBMS and related software. Typically databases available on the database servers are 

accessed through command line or graphic user interface tools referred to as Frontends; 

database servers are referred to as Back-ends. Such type of data access is referred to as a 

client-server model. 

 
Advantages of Database 

 Reduces Data Redundancy 

The database management systems contain multiple files that are to be stored in many 

different locations in a system or even across multiple systems. Because of this, there 

were sometimes multiple copies of the same file which lead to data redundancy. 

This is prevented in a database as there is a single database and any change in it is reflected 

immediately. Because of this, there is no chance of encountering duplicate data. 

 Sharing of Data 

In a database, the users of the database can share the data among themselves. There are 

various levels of authorisation to access the data, and consequently the data can only be 

shared based with the authorized users. 

Many remote users can also access the database simultaneously and share the data 

between themselves. 

 Data Integrity 

Data integrity means that the data is accurate and consistent in the database. Data Integrity 

is very important as there are multiple databases in a DBMS. All of these databases 

contain data that is visible to multiple users. So it is necessary to ensure that the data is 

correct and consistent in all the databases and for all the users. 

 Data Security 

Data Security is an important concept in a database. Only authorised users should be 

allowed to access the database and their identity should be authenticated using a username 

and password. Unauthorised users should not be allowed to access the database under any 

circumstances as it violates the integrity constraints. 
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 Privacy 

The privacy rule in a database states that only the authorized users can access a database 

according to its privacy constraints. To secure data levels are set in the database and a 

user can only view the data which is allowed to be seen. For example - In social 

networking sites, access constraints are different for different accounts a user may want 

to access. 

 Backup and Recovery 

Database Management System automatically takes care of backup and recovery. The 

users don't need to backup data periodically because this is taken care of by the DBMS. 

Moreover, it also restores the database after a crash or system failure to its previous 

condition. 

 Data Consistency 

Data consistency is ensured in a database because there is no data redundancy. Data 

Consistency means there should be multiple mismatching copies of the same data. All 

data appears consistently across the database and must be same for all the users viewing 

the database. Moreover, any changes made to the database are immediately reflected to 

all the users and there is no data inconsistency. 

 
Features of Database 

 

Let’s look at the example of your address book. What do you store in an address book? 

You may have people’s name, address, phone number and maybe even their birthdays. 

There is a common element here – people. In this example, each person is considered an 

“ITEM”. 

So, database will store information about that person. When you were recording 

information in your address book, what did you ask the people? What is your address? 

What is your phone number? etc. Each question that we ask about our ITEM is a “field”. 

Now, say you make new friends and want to add their information to your address book. 

You will ask questions, get the answers and create a new “record”. So, a record is a set 

of information (made up of fields) stored in your database about one of the items. A 

“value” is the actual text or numerical amount or date that you put in while adding 



5 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

information to your database. When you put all the information together in a grid (like 

you do in a spreadsheet), a collection of similar records creates a table. 

There are some key features of a database: 
 

1. A database can have one or many tables. An address book example is a very simple 

one, in real world there are many more details involved. A big company would have 

in its database, one table for its products, one table for its suppliers, one table for its 

customer details, one for orders received and maybe many others. 

2. Each table in a database contains information about one type of item. So, a database 

is a container that holds tables and other objects and manages how they can be used. 

3. Another very important thing to remember is that when we put in information, we may 

have people with the same name (there can be more than one Charu Arora) or the same 

address (members of a family). But when creating a database an important feature is 

record uniqueness in every table. it is important to be able to distinguish between 

different items having duplicate values. 

Uniqueness helps to avoid accidental duplication of records caused by user or 

computer error. This can be achieved by using some number or value that uniquely 

identifies a record. If such a unique value does not exist in your fields, as the database 

designer, you can create a special additional field in a table where unique numbers or 

values can be assigned for each new entry. Therefore, every table has a key field which 

ensures that there are 100% unique values throughout the database. 

4. Every database table should have one or more fields designated as key. You can 

assign a unique value to this key for differentiating records that may have similar 

names or addresses. 

 
Look at the following example of student database: 
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In this table, it will be extremely difficult to differentiate between student records as they 

have names that are similar. To differentiate, you can add additional field - roll number - 

that will be unique for each record (example below). 
 
 

 

 
EXAMPLE OF RDBMS 

 

You had used the example of an address book in the previous section. An address book 

uses only one table. But look at a different situation. If you are a dealer selling a single 

type of item and want to record details of your sales in the past month and also want the 

details of the client who purchased the item ( name, address, phone, date purchased, 

number of items bought etc), what would you do?. 

You create a table Sales with all the details: 
 

 

Do you see a problem here? Every time you sell an item to Sheela or Vaibhav or any other 

customer (client) you need to store the details again. So, what is the solution? Create one 

table for client details and another for sale details. Since each record has to be unique, 

you can insert a ClientID field to uniquely identify each client in the client table. In the 

Sales table, you would give a point of reference which “points” to a particular record in 

the Client table. 
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In the example here, the field ClientID occurs once in the Client table, but since one client 

can place many orders, it occurs a number of times in the Sales table. Since we cannot 

have an order without a customer, we call Client the parent and Sales the child table. 

Related tables like these share a common field. You store data about people once, but 

refer to those people many times in the database. 

When data is to be stored, maintained, and retrieved from multiple tables then special 

database software are required known as Relational Database Management System. 

In the RDBMS data can be integrated using keys. These are Primary Key, Composite 

Primary Key, and Foreign Key. 

This unique field is called the Primary Key (PK). A primary key is a unique value that 

identifies a row in a table. In our example, ClientID is the primary key in the Client table. 

Primary Keys are also indexed in the database, making it faster for the database to search 

for a record. When primary key constraint is applied on one or more columns then it is 

known as Composite Primary Key. 

The referred field ClientID which occurs in the Sales table is called the Foreign key (FK). 

Hence, the foreign key identifies a column or set of columns in one (referencing) table 

that refers to a column or set of columns in another (referenced) table. The “one” side of 

a relation is always the parent, and provides the PK attributes to be copied. The “many” 

side of a relation is always the child, into which the FK attributes are copied. Memorize 

it: one, parent, PK; many, child, FK. 

 



8 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

Another point to remember is that the end users will/may never have direct access to the 

database. They can only see what you permit them to and can select only from the options 

you give them. 

 
RDBMS 

A relational database is a type of database. It uses a structure that allows us to identify 

and access data in relation to another piece of data in the database. Often, data in a 

relational database is organized into tables. 

 
ACTIVITIES 

 

1. Analyze database requirements for a retail shop. Record the business requirements and 

document. (You can use this information for creating a database to suit this business 

requirement) 

2. Analyze database requirement for your school; visit different departments such as library, 

student admission center, to gather requirements. Document the business requirement. 

(You can use this information for creating a database to suit this requirement 

 
ASSESSMENT 

 

Fill in the blanks: 

 
1. A  is an organized collection of data. 

2. A  is a software package that can be used for creating and managing 

databases. 

3. A  is a database management system that is based on the relational 

model. 

4. Three popular DBMS software are  ,  , &  . 

5. A   

table. 

is a unique value that identifies a row in a 

6. Composite Key is a combination of  columns. 

 
Short Answer Questions 

1. What does DBMS stands for? 

2. What does RDBMS stands for? 

3. How is data organized in a RDBMS? 
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4. State the relationship and difference between a primary and foreign key? 
 

 

 

SESSION2:CREATE AND EDIT TABLES USING WIZARD & SQL COMMANDS  
 

Relevant Knowledge 

Data in a relational database management system (RDBMS) is organized in the form of 

tables. 

You will now quickly recap what you learnt in the last session and assimilate more 

concepts. 

 
RDBMS 

A relational database is a collective set of multiple data sets organized by tables, records 

and columns. Relational database establish a well-defined relationship between database 

tables. Tables communicate and share information, which facilitates data searcheability, 

organization and reporting. A Relational database use Structured Query Language (SQL), 

which is a standard user application that provides an easy programming interface for 

database interaction 

 
DATABASE OBJECTS 

Tables: 

A table is a set of data elements (values) that is organized using a model of vertical 

columns(which are identified by their name) and horizontal rows. A table has a defined 

number of columns, but can have any number of rows. Each row is identified by the values 

appearing in a particular column identified as a unique key index or the key field. 

 
Columns or Fields or Attributes: 

A column is a set of data values of a particular simple type, one for each row of the table. 

The columns provide the structure according to which the rows are composed. For 

example, cFirstName, or cLastName are fields in a row. 

 
Rows or Records or Tuples: 

A row also called a Record or Tuple represents a single, data item in a table. In simple 

terms, a database table can be visualized as consisting of rows and columns or fields. Each 
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row in a table represents a set of related data, and every row in the table has the same 

structure. 

 

 
CREATING DATABASE USING OPENOFFICE 

 

There are a variety of DBMS/RDBMS available; in this exercise, you will learn about 

OpenOffice Base an Open Source RDBMS. 

 
• To open OpenOffice, click Start>Programs>OpenOffice.org 4 > 

OpenOffice.org. 

Alternatively, you can also double-click on the OpenOffice.org 4 shortcut on the 

desktop if available. You should see a Window similar to the one displayed below 

FIGURE 1 

 
Select the option database to open the base application. 

You can also directly open the OpenOffice Base Application by doing the following: 

• Click Start>Programs>OpenOffice.org 4>OpenOffice.org Base. 

You should be guided through the Database Wizard for creating a database. 

You will see a dialog box similar to the one displayed below. 
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FIGURE 2 

You can create a new database by selecting the option Create a new database. 

You can also open an existing database file that you have already created by selecting the 

option Open an existing database file. Click Next. 

 
A dialog box similar to the one displayed below appears. 

Figure 3 
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Click Finish. The Save As dialog box appears as shown below. 

Specify a name for the database in the File name: field and click Save. A window similar 

to the one displayed below. 

Click Finish. The Save As dialog box appears as shown below. 

Figure 4 

Specify a name for the database in the File name: field and click Save. A window similar 

to the one displayed below. 

Figure 5 
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Now that you have created a database, you can work with the database as outlined in the 

next few sessions. 

 
Steps To Create A Table Using Table Wizard 

Tables are the basic building blocks of a database. You store the data in the database in 

the form of tables. In the previous exercise you have learnt how to create database objects 

in OpenOffice. 

In this exercise you will learn how to create a table in a database. 

After creating the database, you see a window as shown below. 

There are different ways to create a table: 

1. Create table in Design View 

2. Use Wizard to Create Table 
 
 

Figure 6 

Use Wizard To Create Table: 

A table can be created using the predefined steps and table structure(s) in Base. 

The following are the steps to create a table: 
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Click on Tables > Use Wizard to Create Table , the window shown below will open 

FIGURE 7 

Click the Select Fields > Choose Category > Select the table (in the picture shown below 

“Business” category and “Customer” table has been chosen) > Click on Next Button. 

FIGURE 8 
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Select the fields as per the requirements and select on buttons to add the predefined 

columns or select  to remove the fields from the Selected Fields Box. After selecting 

the fields click on Next Button. 
 
 

FIGURE 9 

 
Once the fields will be selected the window to set the data types will open, By default all 

the fields will have Text[VARCHAR] data type which can be and other properties with 

default values but all of them can be selected as per the requirement. 

 
Click on Next Button 
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FIGURE 10 

After setting the properties of the fields such as field name, type etc. The window to set 

the primary will open. Base automatically adds the column to be set as Primary Key which 

will help the user to enter the unique values and helps in creating the relationship with the 

other table to extract the data from multiple tables. 

After setting the Primary Key click on Next Button. 

FIGURE 11 
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When the Primary Key will be set then window to rename the table will open. A user can 

either go ahead with the same table name or can change it. 

In the same window options to work with the table will be given as : 

The option to insert the data immediately will be selected by default . Click on Finish to 

insert the data in the table. 

 

FIGURE 12 

To insert the data the following window open: 

FIGURE 13 
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Creating table using Design View 

 

1. Click on Create Table in Design View… option available under Tasks and a Table Design 

window appears as shown below. 

 

Figure 14 

Specify the field name and data type of the field to be created by selecting the appropriate 

type available under Field type dropdown list. 

Now create a table with the following fields displayed below: 

Specify the field name and the data type for each field name. For example, the table 

contains the Name field and the data type of the Name is TEXT [VARCHAR]. You can 

specify the length of the field value. 
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Figure 15 

 
Specify the table name. The default name is Table1. Click OK. 

Figure 16 

A dialog box appears, similar to the one displayed below. 

Figure 17 



20 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

Options to set Primary Key 

 

You are asked to set a primary key for the table you just created. You can select the 

appropriate option to set the primary key or leave the table without a primary key. 

If you click Yes, the application will set the primary key for the first field created 

automatically. If you click No, you should see a window similar to the one displayed 

below. 

 

Figure 18 

Notice the table by the name SDetails created and visible under Tables section. 

 
Data Types: 

Datatypes are used to identify which type of data (value) we are going to store in the 

database. 

Fields themselves can be of different types depending on the data they contain. Data types 

in OpenOffice base are broadly classified into five categories listed below. 

• Numeric Types 

• Alphanumeric Types 

• Binary Types 

• Date time 

• Other Variable types 

 
Numeric Types: 

Numeric data types are used for describing numeric values for the field used in the table 

of a database. Numeric data types in a database can be used for storing information such 
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as mobile number, roll number, door number, year of school admission, true or false 

statements, statistical values, etc. 

The different types of numeric data types available are listed here. 

 
Alphanumeric Types: 

 

Binary Types: 

Binary data types are used for storing data in binary formats. Binary data types in a 

database can be using for storing photos, music files, etc. In general, files of any format 
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can be stored using the binary data type. The different types of binary data types available 

are listed here. 

DATE TIME: 

Date time data types are used for describing date and time values for the field used in the 

table of a database. Date time data types in a database can be used for storing information 

such as date of birth, date of admission, date of product sale, etc. 

 
The different types of date time data types available are listed here. 

 

 

Other Data Types: 
 

 
Create the following records: 
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Table Data View Dialog Box 
 

Figure 19 

Start typing the records in the table with the data provided in the excel sheet and select 

File > Save Current ecord to save data in the table. 

 
ACTIVITIES 

1. Create a database for a stationery shop. 

Hint: Create fields for items, price, colour, vendor, etc. 

2. Create a database for a school library. 

Hint : Create fields for book title, cost, provider, availability, etc 

3. Create a database for maintaining a song collection. 

Hint : Create fields for fields such as artist, movie, year released, etc. 

 
ASSESSMENT 

Fill in the blanks: 

1. A table is a set of data elements that is organized using a model of vertical    

and horizontal  . 

2. A  is a set of data values of a particular type, one for each row of the table. 

3. A  represents a single, data item in a table. 

4.   are used to identify which type of data we are going to store in the 

database. 

5. There are  ways to create a table. 

6. Field properties can be set in both the  and  . 

 
Short Answer Questions 

1. In how many ways tables can be created in Base? 

2. Why are data types used in DBMS /RDBMS? 

3. List datatypes available in Numeric Datatype? 
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4. List datatypes available in Alphanumeric Datatype? 

5. Define the structure of a table. 

6. Differentiate between Tuples and Attributes of a table. 

7. Name different Binary data types. 
 

 

 

SESSION 3: PERFORM OPERATIONS ON TABLE  

 

Relevant Knowledge 

In Base, data is stored in tables which can be inserted, modified and removed using 

appropriate options. 

You will now quickly recap what you learnt in the last session and assimilate more 

concepts. 

 
Inserting Data In The Table 

 

To insert the data in the table, follow the steps: 

Select the table > Double click on it. 

FIGURE 20 

The table will open in Datasheet View in which data new data can be inserted and existing 

data can be updated or removed. 



25 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

 

FIGURE 21 

 
Editing Records In The Table 

To edit the data either click on edit icon  or double on the data in the cell of a table 

and modifications can be done. 

FIGURE 22 

Deleting Records From The Table 

 

To remove the data from the table, follow the steps: 

Select the data > right click on selected data > select the Delete option 
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FIGURE 23 

Field Properties 

 

To change the field properties table structure in design view has to be changed. To 

set the field properties, steps will be followed as: 

Select the table > Right click > Select the option Edit > the table Design View window 

will open 

FIGURE 24 



27 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

In design view there are different properties of fields according to the data type set for 

each field. 

The properties of numeric type data is shown below in the figure. 

Like AutoValue – if set to yes then field will get the auto numeric values. 

Length – By default length of the field is 10 but the size of the field can be set to 

maximum length. 

Default Value – A default value can be set for a field if user don’t provide any value 

while entering the values in the table. 

Format example – This property helps to set the format of the data entered in the field 

such as 91-222-333. 

Figure 25 

The properties of character type data is shown below in the figure. 

Entry Required – if set to yes then it will be must to insert the value in the field which 

means that field cannot be left blank. 

Length – By default length of the field is 10 but the size of the field can be set to 

maximum length. 
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Default Value – A default value can be set for a field if user don’t provide any value 

while entering the values in the table. 

Format example – This property helps to set the format of the data entered in the field 

such as 91-222-333. 

FIGURE 26 

Sorting Data 

Sorting means to arrange the data in either ascending order of descending order. Select 

the column(s) then click on sort buttons. The data will be displayed accordingly. 

 
Unsorted Column (EMP_NAME) Sorted Column (EMP_NAME) 

Figure 27 Figure 28 
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Referential Integrity 

Referential integrity is used to maintain accuracy and consistency of data in 

a relationship. 

In Base, data can be linked between two or more tables with the help of primary key and 

foreign key constraints. 

Referential integrity helps to avoid: 

 Adding records to a related table if there is no associated record available in the 

primary key table. 

 Changing values in a primary if any dependent records are present in associated 

table(s). 

 Deleting records from a primary key table if there are any matching related records 

available in associated table(s). 

Creating and Editing Relationships between Tables 

A relationship refers to an association or connection between two or more tables. When 

you relate two tables, you don't need to enter the same data in separate tables. 

Relationships between tables helps to: 

 Save time as there is no need to enter the same data in separate tables. 

 Reduce data-entry errors. 

 Summarize data from related tables. 

You can create a relationship between any two tables by selecting Relationships… option 

from the Tools menu. 

Figure 29 

https://database.guide/what-is-a-relationship/
https://database.guide/what-is-a-table/
https://help.quickbase.com/user-assistance/what_is_a_table.html
https://help.quickbase.com/user-assistance/creating_a_relationship.html
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Add the tables in amongst which you want to create the relationship. Select the tables and 

click on Add button. 

 

Figure 30 

There are three types of relationships which can be created in tables: 

1. ONE to ONE 

2. ONE to MANY OR MANY to ONE 

3. MANY to MANY 

There are two ways to create the relationships between the tables: 

a. Click on Insert option and select New Relation… option in Relation 

Design window. 

 

Figure 31 
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Select the options as required: 

Figure 32 

b. Drag the primary key column from one table and drop it on the key column of another 

table. 

 

One to One Relationship 

In this relationship, both the tables must have primary key columns. Example: In the given 

tables EMP and DEPT, EMP_ID in EMP table and DEPT_ID in DEPT table are the 

primary keys. 

 

Figure 33 



32 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

One to Many Relationship 

In this relationship, one of the table must have primary key column. 

It signifies that one column of primary key table is associated with all the columns of 

associated table. 

Example: In the given tables EMP and DEPT, EMP_ID in EMP table is the primary key. 

Figure 34 

 
Many to Many Relationship 

In this relationship, no table has the primary key column. 

It signifies that all the columns of primary key table are associated with all the columns 

of associated table. 

Example: In the given tables EMP and DEPT, there is no primary key. 
 
 

Figure 35 
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Remove the Relationships 

The relationships applied on the tables can be removed also with the help of Delete option. 

Right Click on the relationship thread and select Delete option. 

 

Figure 36 

 
ACTIVITIES 

 

Perform the following activities till you are confident: 

1. Create a database to store your academic records using the guidelines below: 

• Useyour roll number as the file name for your database. 

• Create fields such as subject name, required score, passing score and your 

percentage. 

• Set the subject name field as the primary key. Populate your database with your 

most recent exam results0 

 
ASSESSMENT 

 

Fill in the blanks: 

1. The types of languages used for creating and manipulating the data in the Database are 

  &  . 

2. A   is  a standard  for commands that define the different 

structures in a database. 

3. A  is a language that enables users to access and manipulate data in a 

database. 

4. A  is a part of DML involving information retrieval only. 

5. A popular data manipulation language is  . 
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6.   are the basic building blocks of a database. 

7. There are  types of Relationships in a table. 

 
Short Answer Questions: 

1. What is the file extension for databases created using OpenOffice.Org 

Base? 

2. List any three file formats that can be managed using 

OpenOffice.Org Base? 

3. How many types of relationships can be created in Base? Explain each of the them. 

4.What do you mean by Sorting? In how many ways it can be done? 

5. Explain Referential Integrity with the help of an example. 
 

 

 

SESSION 4: RETRIEVE DATA USING QUERY  
 

Relevant Knowledge 

Having created the tables and entering data into them, now you want to extract some 

information. 

That’s when you query the database. As the name suggests, query is to collect specific 

information from the pool of data. A query helps us join information from different tables 

and filter that information. Filtering means that the query uses criteria you provide to 

hide some data and present only what you want to see. 

 
Query Creation Using Wizard 

FIGURE 37 
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FIGURE 38 

Click on Finish 

FIGURE39 
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Creation Of Query Using Design View 

 

Some RDBMS provide a graphical means to create queries, but most RDBMS do not do 

so. That’s where you use SQL (pronounced as “sequel”) or Structured Query Language. 

Query languages are computer languages used to make queries into databases and 

information systems. Queries 

are commands that are used to define the data structure and also to manipulate the data in 

the database. 

A SELECT statement retrieves zero or more rows from one or more database tables or 

database views. In most applications, SELECT is the most commonly used Data 

Manipulation Language(DML) command. 

The SELECT statement has many optional clauses: 

• WHERE specifies which rows to retrieve. 

• ORDER BY specifies an order in which to return the rows. 

 

To retrieve all the columns in a table the syntax is: 

SELECT * FROM <TABLENAME>; 
 

In order to execute queries click on the Queries option available on the left side under 

database section, click Create Query in SQL View as shown below. 

 

Figure 40 

A window appears similar to the one displayed below. 
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Figure 41 

You can type the query in the above window and execute it by using the F5 function key 

or by clicking the icon in the window. 

For example, if you want to display all the data in the table that you created in the early 

session, then the select statement will be: 

Select * from SDetails; 

After executing the select query the output will be shown similar to the one displayed 

below. 

 

Figure 42 

Performing calculations 

In Base, simple calculations can be done on the data using arithmetic operators. 

Example: 

To display the salary of all the employees after incrementing by 1000 then the 

following SQL command will be executed in Base SQL Design 
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Select “EmployeeID”, “FirstName”, “Salary” +1000 

from “Employee” 

FIGURE 43 

To display the salary of all the employees after decreasing by 10000 then the 

following SQL command will be executed in Base SQL Design 

Select “EmployeeID”, “FirstName”, “Salary” - 10000 

from “Employee” 

FIGURE 44 
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To display the salary of all the employees after incrementing it as twice the amount 

of present salary, then the following SQL command will be executed in Base SQL 

Design. 

Select “EmployeeID”, “FirstName”, “Salary” * 2 from “Employee” 

 

FIGURE 45 

To display half of the salary amount paid to the employees, then the following SQL 

command will be executed in Base SQL Design. 

Select “EmployeeID”, “FirstName”, “Salary”/2 from “Employee” 

FIGURE 46 
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Grouping of Data 

To display the records containing the same type of values “WHERE” clause can be used 

with the Select SQL Command. 

To get details about the list of students whose favorite color is blue, you can use: 

select * from SDetails where Color=’Blue’; 

After executing the select query the output will be shown similar to the one displayed 

below. 

 

Figure 47 

To view records in ascending order of RollNo, from the table the select statement will be: 

select * from SDetails order by “Rollno” ASC; 

Figure 48 

You can add, modify or delete records using the Insert, Update and Delete commands. 
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To type and execute SQL commands, click on Tools > SQL. A window similar to the one 

below will be displayed. 

 

Figure 49 

You can type the SQL Commands in the Command to execute space and click on 

Execute. 

UPDATE statement 

Update statement is used for modifying records in a database. The general syntax of the 

update statement is as follows: 

UPDATE <table_name> 

SET <column_name> = value [, column_name = value ...] 

[WHERE <condition>]; 

To update a record using an update statement, type the following and click Execute. 

Update SDetails set Location = ‘Bhubaneswar’ where Rollno = 14; 

Execute select query to view the updated table. After execution you should see a window 

similar to the one displayed below. 

Figure 50 
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Activities 

1. Open the database created in the previous activity. Use the select query statement to query 

and sort on subjects marks scored was greater than 50%. 

2. Create a database for collecting and maintaining census data. Using queries display the 

data of people living in a specific area. 

Hint : Create fields for fields such as First Name, Last Name, DOB, Place of birth, 

Employment Status, etc. 

 
Assessment 

 

Fill in the blanks 

 
1. A  helps the user to systematically store information in the database. 

2. A  enables users to view, enter, and change data directly in database objects 

such as tables. 

3.   statement retrieves zero or more rows from one or more database tables or 

database views. 

4. By default, data is arranged in  order using ORDER BY clause. 

5.   statement is used for modifying records in a database. 

6.   statement is used to remove one or more records in a Database. 

 
Short Answer Questions: 

1. Name DML commands. 

2. What is the purpose of using queries? 

3. Which clause of Select statement helps to display specific data? 

4. Differentiate between Where and Orderby clause of SQL statements. 

5. State the purpose of Update Command with the help of an example. 
 

 

 

SESSION 5: CREATE FORMS AND REPORTS USING WIZARD  

Relevant Knowledge 

A form provides the user a systematic way of storing information into the database. It is 

an interface in a user specified layout that lets users to view, enter, and change data 

directly in database objects such as tables. 
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In this session, you will learn to create a form. 

 
Creating Form Using Wizard 

To create a form, Click on Forms option located under Database section (Figure below). 

Figure 51 

Steps To Create Form Using Wizard 

Click Use Wizard to Create Form… option under Tasks group. The Form Wizard dialog 

box appears as shown below. 

 

Figure 52 

You can select selective fields to be sent onto the form by selecting the field name and 

clicking >button. You can select individual fields in a database or all fields in a database. 
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To use all the fields in the table in a form, click the >> button. 

Notice the fields displayed under Fields in the forms section (Figure below). 
 
 

Figure 53 

Click Next >. You see the Set up a sub form step dialog box of the wizard as shown below. 

Figure 54 

 
You can select the option Add Subform if you need to insert the contents in the table in 

a separate form. Click Next>. 

 
Now you need to arrange selected fields in a form. You can use different styles from the 

list displayed below: 



45 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

 

Figure 55 

Once you have selected a style, click Next > 

A dialog box appears wherein you can select the data entry model. 

Figure 56 

Click Next >. You should see a dialog box wherein you can specify the styles to be used 

in the form. 
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Figure 57 

 
Click Next >. You see a dialog box where you can specify the name of the form. Click 

Finish. 

 

Figure 58 
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A form window appears. Notice that the records in the table are displayed automatically 

within the form that you just created. 

 

Figure 59 

Options To Enter Data From Forms 

You can add new records to the table using the form by clicking the  symbol located 

at the bottom as shown below. 

Figure 41 

Once you click the  symbol, you will be displayed with a window for creating 

records (Figure below). 
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Figure 60 

You have learnt to create records using design view in the earlier sessions. You can add 

records using the form as displayed below. Type the following data in the textbox 

provided in the box as shown below: 
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To view the saved records, Double-click SDetails (Table name) under Tables section. A 

window similar to the one below will be displayed; notice the record that you created 

using a form is also displayed along with other records (Figure below). 

 

Figure 61 

Now enter three more records using the form and view them using the above mentioned 

procedure. 

 
Reports 

A report helps to display the data in a summarized manner. It is used to generate the 

overall work outcome in a clear format. You can create reports in the database. 

 
Concept Of Reports In Base 

The reports can be created using Openoffice Base. 

 
Creating Reports using wizard 

Reports helps to get the summarized data. To create reports in Base, the table must be 

selected from using which data can be displayed in a format as required. 

 
The steps to create followed are : 

 Click on Reports section under Database in the OpenOffice base application. 

 Once you select the option, you should see a window similar to the one displayed 

below. 
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Figure 62 

Now we can generate the report for the table created earlier. 

Click on Use Wizard to Create Report… option available under Tasks. 

Once you select the Use Wizard to Create Report… option. 

You should see a window similar to one displayed below. 

Figure 63 

You have to select all the table fields by selecting the >> button, once you click the button 

>> you should see a dialog box similar to the one displayed below. 
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Figure 64 

Once you click Next>.you should see a dialog box similar to the one displayed below. 

Figure 65 

You can redefine the label of the fields in the reports or else you can set the default name. 

Once you click Next >, you should see a dialog box similar to the one displayed below. 



52 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

 

Figure 66 

You can define grouping for the fields of the table. 

Once you click Next >, you should see a dialog box similar to the one displayed below. 

Figure 67 

You can sort the field variables in the report by selecting the appropriate field and sorting 

method. 

Once you click Next >, you should see a dialog box similar to the one displayed below. 
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Figure 68 

You can select the layout of the report by selecting the appropriate option available under 

the Layout of data down list and you can also select the orientation of the report. 

Once you click Next >, you should see a dialog box similar to the one displayed below. 
 

 
 

Figure 69 



54 

[RELATIONAL DATABASE MANAGEMENT SYSTEMS(BASIC)] | IT | STUDY NOTES   

 

 

You can define a name for the report or you can use the name of the table itself for the 

report also. 

Click Finish. 

Once you click Finish you should see a window similar to the one displayed below with 

the report. 

 

Figure 70 

Now create a report containing only Name, RollNo and Phone details. Use different 

layouts for the report design. 

 
ACTIVITIES 

 

1. Create a form for the academic database created in the above activity. Populate the 

table with mark results using the form. 

2. Create a report to display data from table stored in database created earlier. A report 

must display your entire academic score card. 
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Fill in the blanks: 

 
1. To create a form you need to select  option available under Database section. 

2. A  is helps to collect specific information from the pool of data in the database. 

3.   is used to display the display the summary of data. 

4.   are the interfaces with which the user interacts. 

5. Data from multiple tables can be stored in  . 

 
Short Answer Questions: 

 
1. Why there is a need to create Forms? 

2. What is the purpose of creating Reports? 

3. What are the prerequisites to create a Form and Reports? 

4. Differentiate between Forms and Reports. 

5. Can a form displays data from queries? 

6. In how many ways Forms and Reports can be created in a database? 
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